
  

Revised 12/16/2016 
Page 1 

 

Table of Contents 

Introduction .......................................................................................................................................Page 2 

Start a New Marriage Event ...............................................................................................................Page 2 

Enter A New Marriage Event .............................................................................................................Page 3 

General Tab ........................................................................................................................................Page 3 

Party A & B Tab ..................................................................................................................................Page 5 

Application/License Tab .....................................................................................................................Page 9 

How Add SSN buttons work ...............................................................................................................Page 9 

CAS Application tab ............................................................................................................................Page 13 

Linking to CAS Record (Marriage Application) ...................................................................................Page 15 

Printing Document .............................................................................................................................Page 16 

Adding Waiver ....................................................................................................................................Page 18 

Removing Waiver ...............................................................................................................................Page 20 

Work Queues .....................................................................................................................................Page 22 

Marriage Return .................................................................................................................................Page 23 

CAS Application After Marriage Return .............................................................................................Page 24 

Linking to CAS Record (Initial No Fee Certificate) ..............................................................................Page 25 

Printing the Initial No Fee Certified Copy of Marriage Certificate ....................................................Page 26 

Printing Certified Copy Images ..........................................................................................................Page 28 

Save Without Edits .............................................................................................................................Page 29 

Searching for Marriage Records through CAS ...................................................................................Page 31 

Redacting Marriage Certificates ........................................................................................................Page 32 

Archiving & Scanning .........................................................................................................................Page 35 

Scanning & Attaching Documents .....................................................................................................Page 35 

Blank Marriage Forms ........................................................................................................................Page 41 
  



  

Revised 12/16/2016 
Page 2 

 

Introduction 

The county recorder marriage quide is an addendum to the county recorder IVES user guide.  

For installation, log in, operator and CAS instructions, refer to the county recorder IVES user 

guide.  

Iowa Code 595 governs the process of applying for and receiving a marriage license in the state of Iowa. 

IAC641-98(144) is the section of administrative rules that apply to marriage license issuance. 

 

 

 

Start a New Marriage Event 

 

 

 

 

 

 

To start a new marriage event: 

Click on File>New Event> Marriage 

 Short-cut: you can use CTRL+M on your keyboard to 

open a new marriage event. 
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Entering a New Marriage Event  
General Tab 

 

 

 

 

   

 

 

 

 

 

 

 

 

The marriage event is separated by tabs: 

General; Party A; Party B; Application/License; Marriage Return; Flags; CAS Application.   

 The new marriage event will always open to the General tab.   
 

First, enter the Application Date 
 The application date can be back-dated up to 3 calendar days only. 

o Short-cut: Enter ‘T’ for the current day’s date; press ‘B’ to backdate the day field. 

 The valid date will auto populate to include the correct calculate of the 3-day waiver. 

If there is a 3-day waiver, enter ‘Y’ 
 The valid date will re-populate with the new date. 

The Filing County, Reg Type Code, and Record Status are all default fields that can not be changed. 
 

Things to Remember 
 County License #: Once the license has been marked complete by the user on the Application/License tab, 

the County License # will populate. 

 State File Number: Once the Certificate of Marriage has been returned to the county for filing, and the 

Marriage Return tab is completed, the State File Number will populate. 
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Completed view of the General Tab with no 3-day waiver: 

 

Completed view of the General Tab with a 3-day waiver: 

 



  

Revised 12/16/2016 
Page 5 

 

Party A & B Tab 

The fields on tabs Party A and Party B are identical. 

Use the below instructions for guidance on both Party A and Party B tabs. 

 

 

 

 

 

 

 

 

Party A & B Tabs: 

The following are paragraphs within the Party A & B tabs: 

 Party A – Current Name 

 Party A – Name after Marriage 

 Residence Address Information 

 Birthplace 

 Parent Names (optional) 

Things to Remember 
 Optional – All optional fields or paragraphs are labeled as optional. 

o On Party A & B tabs, Party designation, city, county, gender and parent names paragraph are 

optional. 
 

Paragraphs are titles with blue writing, and 

separated from each other using a light blue border. 
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Party A & B Tabs: 

Party A or B – Current Name – Enter the current legal name in each field listed 
 First Name 

 Middle Name (if applicable) 

 Current Last Name 

 Last Name prior to any marriage (generally, this is the name on birth certificate) 

 Suffix (if applicable) 

Party A or B – Name after marriage 
 First Name 

 Middle Name (if applicable) 

 New Last Name 

 Suffix (if applicable)  

 
 

Things to Remember 
 Name after marriage – The name after marriage is the legal name of the individual once they get married.  

Either party to a marriage can change any part of their name through the marriage process.  It will take a Legal 

Change of Name court action to change the Name After Marriage once the marriage ceremony has been 

performed.  

 Designation – Designation of Bride, Groom or Spouse is optional and not required.  

 Save without Edits – To save a marriage event without completing the event and signing the license as 

complete, you must enter at a minimum:  

o Application Date 

o Party A – Current Name 

o Party B – Current Name 

 Once these fields have been entered, click File>Save without edits  

 

 

 

 

As a convenience, the first and middle name entered in the Current 

Name fields will default to the Name After Marriage fields. 

You must enter the Last Name in the Name After Marriage field. 
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Party A & B Tabs: 

Party A or B – Residence Address Information 
 Country and State - currently Country and State defaults to United States and Iowa.  This information is to be changed to the 

appropriate location as needed. 

 City and County – Choose the city and county from the drop-down list. 

Party A or B – Birthplace 
 Country and State - currently Country and State defaults to United States and Iowa.  This information is to be changed to the 

appropriate location as needed. 

 Enter the date of birth.  The age will autocalculate. 

o If either party to be married is 16 or 17, they must submit a Consent to Marry form, and the Consent box must be marked 

with a ‘Y’.   

o If either party is under the age of 16, the system will not allow the marriage license to be signed as complete. 

 Enter gender as ‘M’ for male, ‘F’ for female, ‘U’ for unknown. 
 

Things to Remember 

 Location drop-down lists – If the individual was born in a country that does not have states, choose OTHER from the STATE 

drop down and complete the type-field.  Also, call the IVES Help Desk to have the state added. 

 
 Consent – The consent box will gray-out if the person to marry is 18 or older.  The consent box must be completed if the person 

is 16 or 17 years old. 

 Gender - Gender is optional and self-reported.  Options are F, M, U. 

Completed view of Party A or B tab age 18 or older: 
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Party A & B Tabs: 

Parent Names (optional): 
 Parent designation is Father, Mother, Parent and is optional 

o To leave field blank, tab out of parent designation field 

 Enter at a minimum: 

o Parent 1 First Name 

o Parent 1 Last Name prior to any marriage 

o Parent 2 First Name 

o Parent 2 Last Name prior to any marriage 

Things to Remember 
 Optional – Listing parents are optional 

o Not all applicants have two parents, and it is possible for someone to not have parents. 

 Who should be listed as a parent – The parties to marry can list anyone as their parent. 

o The applicant can enter one or both parents regardless of birth certificate information.  It is not required to list 

two parents on marriage documents. 

o It is recommended to list the parent/parents as stated on birth certificate. 

o If they choose to list someone who is not listed on their birth certificate, the applicant needs to consider how 

this will impact them when applying for identification documents (drivers license and passport). 
 

 

  

Completed view of Party A or B tab age 16 or 17 requiring a Consent to Marry form: 
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Application/License Tab: 

Social Security Numbers: 
 Each Add SSN button works the same 

 System accounts for persons with no social security number 

 You can correct a SSN once entered. 

 The system hides the SSN after the number has been entered. 

 The system asks for verification that the correct number has been entered. 

 

Anticipated Ceremony: 
 Both the Anticipated Ceremony Date and Anticipated Officiant are optional 

Anticipated Ceremony: 
 Once the license box is  marked ‘Y’ for complete, any errors or missing information will be displayed in a dialog box. 

 If the application is error-free, tab out of the License complete box and the Date Completed and Completed By will 

autopopulate. 

 
 

 
 

How the Add SSN buttons work 

Click the Add SSN for Party A button 
 

 

 
 

Application/License Tab 
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 The dialog box appears that asks for the 

party’s social security number.  

 A total of 9 numbers can be entered.  

 You will receive an error if you do not enter 

enough numbers or too many numbers. 

 Do not use any dashes or spaces. 

 Click OK when finished. 

 

 

 

 

 Once the SSN is entered, and you click OK, a 

dialog box will appear that repeats the 

number. 

 If the SSN is correct, click YES. 

 If the SSN is not correct, click NO and 

reenter. 

 

 

 

 
 This dialog box appears showing 

that a SSN has been successfully 

entered for Party A. 

 

Repeat same process for Party B. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Completed view after 9 numbers have been 

entered: 
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If you click on a Add SSN button after 

the number has been successfully 

entered, the following dialog box 

appears. 

 Click NO to exit; 

 Click YES to correct number. 

 

 

 

 

If someone does not have a SSN, 

enter the number ‘9’ and click OK. 

 

 

 

 

The following dialog box states that ‘You have 

indicated that Party A/B’s SSN is unknown, is 

this correct? 

 Click YES if correct 

 Click No is not correct, and re-enter number. 

 

 

 

 

The following dialog box will appear stating that 

the SSN has been updated. 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you click on the Add SSN button once a number has been entered: 
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License Complete 
 Review all tabs for correct and accurate information 

 Enter a ‘Y’ in the License Completed field and tab. 

o If there are no errors with the record, the current date and user name will default in the next fields. 

o If there is missing information that is required, a pop up will appear directing the user to correct or add 

information. 

 Click on Save in top right corner when completed.  

 

 

Anticipated Ceremony Date & Anticipated Officiant 
 Enter the anticipated ceremony date if known 

o The date must be equal to or greater than the valid date of the marriage application. 

 Enter the anticipated officiant 

Things to Remember 
 License Complete field 

o You must tab through the Aniticpated Ceremony date and Anitipcated Officiant fields for the License 

Complete field to open for entry. 

o The License Complete field will not open if required information is missing.  Complete all required 

fields. 

 

 

Note: Both fields are optional 

 

 

 

 

 

 

 

 

 

 

The license will receive a 

County License #.  The County 

License # can be found on the 

General Tab. 
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CAS Application – You must create a CAS Application and add the payment from the Marriage Module 

for ALL marriage licenses issued. DO NOT create CAS application through the FEE/CAS Application menu. 

Create CAS Application & Request 
 Choose Party A or Party B 

o That name after marriage will default  
 Enter the mailing address 

 Click Create Application & Request button 

 The total amount owed will autocalculate 

 

Payment: 
 Choose Payment Type; enter Check/MO number is required; enter amount collected. 

 Click Add Payment button.  
 The application ID is at the bottom of the screen under paragraph CAS IDs. 

 
 

CAS Application Tab 
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Do Not click Add Certificate to Request at this point! 

 

 

   

 

 

 

 

 

 

#1: Mailing 

#2: Click Create Application & Request 

#3: Add payment type and amount 

#4: Click Add Payment button 

Completed view of CAS Application 

tab: 
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Linking to CAS Record (Marriage Application) 

 

 

Linking to CAS Record 

The CAS Application with the Request and 

Payment is created.  To get to the 

application to view the service and  

complete the application you will need to: 

 Go up and click on the Linking 

menu at the top of the page  

 Click on Applicant 

 

 

 

This will give you the results of the CAS 

application for Party A or B (which ever 

one you picked). 

 Click Display or double click on 

the grid to open up the 

application. 
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After the CAS Application has been created and the 

payment entered, documents will be available to print 

from the IVES Requests/Documents print menu. 

 

 

 

 

 
 

 

Printing Documents 

 

 

 

 

 

 

 

The application shows the requests for the 

marriage application service as COMPLETED.  

The payment of $35 is added. 

 Change the Status on the 

application from PENDING to 

COMPLETED > type in the Date 

Completed > Save > Close 

This will remove your application from the 

CAS pending work queue. 
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Printing Options for Specific 

Documents 
 There are 2 two-sided documents that are 

available print from the marriage event: 

application to marry; Certificate of 

Marriage. 

 If you choose either of these documents 

to print, you will get a pop-up box of your 

printer’s default preferences. (Not all 

dialog boxes will appear as the image 

above.) 

 Verify the printer, and click the 

Preferences button. 

 Use the tabs to locate the Print on Both 

Sides or Print Double Sided option; 

choose this option to print that document 

on both sides. 

 Click OK; Print 

o If you have a printer that does 

NOT print on both sides, follow 

the above process.  The first 

page of the document will print; 

put the print document back in 

the printer (bi-pass or tray) to 

print the second page. 
 

Things To Remember: 
 Marriage regulations have not changed.  All the same documents are needed to process a marriage. 

 Print the appropriate documents from the Documents print menu.   

o If you do not need a 3-day waiver or Consent for Minor, do not print them. 

o All documents will be available for every record created. 
 

Fix a Mistake 
 If you find a spelling mistake or other error, simply correct the information, click Save and reprint 

document. 

 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remember: Your print boxes may look different than the above images. 
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Adding Waiver from Marriage Record and CAS 

 

 

 

 
 

 

 

 

 

Step 2

 

 

Adding 3-day waiver 
 
Open up the marriage event, go to the CAS 
Application tab.  On the CAS Application tab: 
 

1. Click on the Add Waiver button which 
will change the Total Amount Owed 
from $35 to $40 

2. Message pop-up stating the Waiver 
Service Added to Order > click OK 

3. Go to the Payment paragraph>change 
the Amount to $40  

4. Save  
5. Message pop–up stating the record has 

been successfully saved > click OK 
 

Note: The General tab will show the 3 Day 

Waiver box changed from a “N” to a “Y” and 

the Valid Date field will also change to the 

appropriate validation date. 

 

 
 

S t e p  1  

Step 5

 

 

Step 1 

     Step 3 
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On the CAS Application tab of the marriage record: 

 Go up to the Linking menu > click on 
Applicant 

 Double click on the application result to get 
to the Application request.   

 
The marriage application request now shows $40 
w/the added $5 waiver service.  
 

  
 
You will need to change the payment to reflect the 
amount. 
 

 Double click on the existing payment > 
change the amount. 

 Save > Close 
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Remove Waiver from Marriage Record and CAS 

 

 
 

 

 
 

 

 

 

Removing 3-day waiver 
 
Open up the marriage event, go to the CAS 
Application tab.  On the CAS Application tab: 
 

1. Click on the Remove Waiver button which 
will change the Total Amount Owed from 
$40 to $35. 

2. Message pop-up stating the Waiver 
Service was removed from order > click 
OK 

3. Go to the Payment paragraph>change 
the Amount to $35  

4. Save  
5. Message pop–up stating the record has 

been successfully saved > click OK 
 

Note:  The General tab will show the 3 Day 

Waiver box changed from a “Y” to a “N” and the 

Valid Date field will also change to the 

appropriate validation date. 

Step 2

 

 

 

Step 1 

Step 3 

Step 5
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On the CAS Application tab of the marriage 

record: 

 Go up to the Linking menu > click on 
Applicant 

 Double click on the application result 
to get to the Application request.   

 
The marriage application request now shows 
$35 w/the removal of the $5 waiver service.  
 

  
 
You will need to change the payment to 
reflect the amount. 
 

 Double click on the existing payment > 
change the amount. 

 Save > Close 
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Work Queues 

  

 
 
CAS Requests Pending:  The CAS Requests Pending work queue contains all CAS applications that are marked as 

PENDING on the application screen.  Applications found in the CAS pending work queue are either certified copy requests 

submitted funeral directors, county has not received the payment, and CAS applications created from the marriage 

module.  CAS applications that are marked COMPLETED will be removed from this work queue. 

 

M App Pending:  The M App Pending work queue shows the marriage records that have been started, but the LICENSE 

COMPLETED box is NOT marked “Y” and without the completed date and signature. 

 

 

 

 
M Pending Marriage Return:  The M Pending Marriage Return work queue shows the marriage records that have been 
marked ‘Y’ in the LICENCE COMPLETED box with the completed date and signature. The records that appear in this work 
queue, the Marriage Return tab is not complete as the county is waiting on the 
Certificate of Marriage to be signed and returned. 
 

 

 

 
Refresh Work Queue Counts: The numbers displayed beside each work queue represents the number of records in that 
work queue.  Click on Refresh Work Queue Counts to display the most recent 
count of records.  

 

 

 

CAS Requests Pending 

 M App Pending 

 M Pending Marriage Return 

 

Refresh Work Queue Count 
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Marriage Return: 
 Once a Certificate of Marriage is signed and returned to the issuing office for filing, the user needs to mark the 

marriage as complete in IVES. 

 On the Marriage Return tab, enter the Date of Marriage – a pop up will appear to verify the correct record is being 

registered, the Place of Marriage, and the County and City or Location 

o This must be in IOWA. 

 Date Filed field defaults to the Date of Marriage – Recorders can change the date to match their signature on the 

certificate. 

 Enter ‘Y’ for Record Complete and tab out of field. 

 The Date Completed and Completed By will default with the current date and the user. 
 

This pop-up will appear that 

states the record has been 

numbered.  Click OK. 

 

A pop-up will appear that shows 

that the record was successfully 

saved.  Click OK. 

 

DO NOT CLICK SAVE AT TOP 

 

Verify Registrants pop-up will 

appear after entering the Date 

of Marriage.  Verify>Click OK. 

 

 

 

 

Marriage Return Tab 
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CAS Application Tab after Marriage Return Filed 

 

 

 

 

 

 

 

 

New Address? 

If the address of the couple has change, enter the 

new address here.  The address will change in CAS. 

 

Add Certified Copy Request to the CAS Application 

To add the certified copy request to the CAS 

application, go to the CAS Application tab, click on 

the Add Certificate to Request button. 
 You can only click this button once.  If the couple wants 

more than one certified copy, all additional requests 

must be entered into CAS manually. 
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Linking to CAS Record (Initial No Fee Certificate) 

 

 

Linking to CAS Record 

The No Fee Certiifed copy request is 

added to the CAS application.  To get to 

the application to complete the service 

you will need to: 

 Go up and click on the Linking 

menu at the top of the page  

 Click on Applicant 

 

 

 

This will give you the results of the CAS 

application for Party A & B (whichever one 

you picked). 

 Click Display or double click on 

the grid to open up the 

application 
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 Printing the Initial No Fee Certified  

Copy of Marriage Certificate 

 

 

 CAS Application  

 The request for the No Fee certified has been added 

to the Marriage Application request changing the 

status to PENDING. 

 Double click on the marriage request. 
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CAS Service 

 Highlight the pending service>click on Search for Event Record> go to 

Request/Documents> Documents> M CERT COPY MARRIAGE COUNTY 

 Use State IVES paper (blank paper).  Enter the state safety paper number> click OK 

 Save and Close 
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Example after State scans Certificate of Marriage: 

 From the Request/Documents menu, view of M CERT IMAGE MARRIAGE COUNTY document 

 

 

 

 

 

Printing Certified Copy Images 

 Create CAS application and enter service. 

 Highlight the service, Search for the Event Record>go to Request/Documents> Documents> Choose 

o M CERT IMAGE MARRIAGE COUNTY 

 Use State IVES paper (blank paper). 

 

 

 

Printing Certified Copy Images 
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Once the fields have been completed: 

File>Save without Edits 
 

Save without Edits 

 

 

 

 

 

 

 

 

 

 

The marriage event can be saved once the following fields have been completed: 

Application Date and Valid Date 

 Remember: Valid Date is a default based off the 3-Day waiver information 

Party A & B – Current Name 

 First Name 

 Current Last Name 

 Last Name prior to any Marriage 

Party A & B – Name After Marriage 

 First Name 

 Last Name 
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CAS Application – After Save without Edits, you can click on the CAS tab and create and application, 

request and pament 

Create CAS Application & Request 
 Choose Party A or Party B 

o That name after marriage will default  
 Enter the mailing address 

 Click Create Application & Request button 

 The total amount owed will autocalculate 

 

Payment: 
 Choose Payment Type; enter Check/MO number is required; enter amount collected. 

 Click Add Payment button.  
 The application ID is at the bottom of the screen under paragraph CAS IDs. 

 
 

#1: Mailing 

Address 

 
#2: Click Create Application & Request 

 

#3: Add payment type and amount 

 

#4: Click Add Payment button 

 

Things To Remember: 
 Do NOT print the document listed under Request/Documents 

o These documents will not be complete until after you finish the application process and mark the 

License as complete. 

 If you need to change the Application date, simply enter the new date, and tab out of the field.  This will 

update the Valid Date of the marriage. 

o This is only required if the application process is being completed after the 3 day waiting period has 

passed or the applicants come back with a 3-day waiver. 

 Once you have completed all the information in the IVES system, and the record is marked License Complete, 

click on the SAVE button.  This will update the documents so all the information prints correctly. 
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Searching for Marriage records in CAS 
 The Search for Event Record button looks for the name listed as Party A on a marriage record 

 If the search information listed in the CAS request screen is Party B, you will receive a pop-up that 

states ‘No Record Found’ 

 

When this happens, go to the 

Linking>Event Alt Search 
This will search the name in the Party B field 

 

 

 

Searching for Marriage records from Marriage Search Screen 

 From home screen, Search>Marriage 

o The search fields include Party A name and Party B name 

o If you receive a pop-up stating No Record Found, you need to search the other Party 

name fields. 

 

 

Searching for Marriage Records through CAS 
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Redacting Marriage Certificates 

 

 
 
Select Requests/Document>Documents>M CERT IMAGE MARRIAGE COUNTY 

 
 
Enter safety paper number > Click OK 

 
 

Image will appear with the option to redact.  If you do not need to redact, go to step 7. 

 

On the CAS Service, click on Search for 

Event Record button 
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Process to Redact marriage image 

Right click on the image and select the shape you want to use.  

 

               
  

Right click on the shape to alter the color as needed. 

 

               
 
 

Select Modify>Properties.  This will launch a dialog box for altering the color, size of lines and fill.  Choose color 
as needed (generally black).  Click OK to accept changes. 
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Move and re-size the shape to redact a field on the document. 

                   
 

Click OK on the image  
 
The next screen to appear is the Print Preview screen where you can print the document. Click on the print icon 

 
 
The Printer option will appear; your default printer will be highlighted.  Click the Print button  
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Final Steps 

 Original Certificate of Marriage documents MUST be mailed to the State for review 

 Counties MAY scan all the marriage documents to IVES. 

o If the county chooses to scan and attach all marriage documents into IVES, the original 

documents may be destroyed AFTER the Certificate of Marriage has been filed and sent to the 

State. 

o Applications of license to marry are public documents once the license has been picked up or 

mailed to the applicants. 

o Counties need to email the State when licenses are not picked up within 6 months of the 

application date. 

 The State will deactivate the record. 

 

Archiving and Scanning 

 

 

 

Scanning & Attaching Documents 

 
 

 
 

 

 

Have the marriage record open  

 Select Actions from the menu 

 Select one of the 3 options: 

1. Scan Image  

2. Load Image from File  

3. Load PDF/Word Documentation  

Below are the instructions for the 3 different 

options to scan and attach documents. 
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OPTION 1: Scan Image (if you have a scanner attached to your computer and it allows 

you to load the image to the application)  

 

 

 

  

 

 

  

 

Click Scan Image from the Action Menu 

 

 

 

 

New Image/Document screen will  appear – 

Enter a description for the document. 

Click OK 

Insert document (application) to be scanned 
into the Scanner 
 

 

 

 

 

 

The Properties Dialog will appear – Select OK 
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OPTION 2: Load Image from File (If you have a scanner that requires you to save it as 

an image -> use this option) 

 

 
 

 

 

The Display Image/Document Selection will appear 

with the file you scanned.   

 

Click Close 

 

This will bring you back to the marriage record.   

 

 

 

 

 

 

Scan the application and supporting documentations (if 

applicable) through your scanner  which will require you 

to save the Image as a jpeg or tiff on your computer. 

 

On the application, click on the Actions menu>Load Image 

From File 

 

 

 

 

New Image/Document screen will  appear – 

Enter a description for the document. 

Click OK 
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Find your saved image file   

Click on it, this will filter into the “File 

Name” field. 

Click Open 

 

 

 

 

A window will appear that allows you to 

select your saved image file.   
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OPTION 3: Load PDF or Word Document (If you have a scanner that requires you to 

save it as a PDF or Word Document -> use this option) 

 
 

 

 

 

The image will appear 

Click Save to File  

*Note: you can choose the type of file you 

want to save by clicking on the dropdown 

 

 

 

New Image/Document screen will  appear – 

Enter a description for the document. 

Click OK 

 

 

 

 

 

Scan the application and supporting documentations (if 

applicable) through your scanner  which will require you to 

save it as a PDF or a Word Document on your computer. 

On the application, click on the Actions menu>Load PDF/Word 

Document 

 

 

 

Marriage 
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The image will appear with the 

description of the image 

Click Save to File 

The screen will disappear and bring 

you back to the application or 

service screen.   

 

 

 

 

 

Find your saved PDF or Word Document   

Click on it, this will filter into the “File Name” 

field. 

Click Open 

 

 

 

 

A window will appear that allows you to select 

your PDF or Word Document.   
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Blank Marriage Forms 

 Blank Marriage Forms are available to print from the Home Screen>Blank Forms. 

 

 
 

Blank Marriage Forms 

 


